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About SensiGuard 
 

SensiGuard is a program that allows you to secure your personal data, store your passwords and protect 

your USB drives in a quick and easy way.  

 

With SensiGuard you can: 

 

• Protect your financial records, personal documents and photos 

• Prevent hackers and privacy invaders from accessing your files and protect yourself from identity theft 

• Protect files stored on USB flash drives and memory cards 

• Travel with confidence—your data is secure even if your laptop is ever lost or stolen 

 

SensiGuard uses advanced encryption algorithms that offer 100% protection of your data. With 

SensiGuard you won’t have to worry about your files being stolen ever again. 

 

Installing SensiGuard 
 

Installing SensiGuard is very easy even if you are a novice user. SensiGuard’s installer has a very intuitive 

interface, which means that installing the program is as easy as following onscreen instructions. 

 

To Install SensiGuard: 

 

1. Locate the sensiguardsetup.exe file on your desktop or in your download folder and double-click the 

file to begin the installation process. If you haven’t downloaded the setup file yet, you can download it 

now from http://www.sensiguard.com/download. 

2. Depending on the operating system you use, you might get a UAC prompt. Click Allow. 

3. Follow the installer’s onscreen instructions to complete the installation. If you need any further help, 

please visit our support page at http://www.sensiguard.com/support. 

4. Once you install SensiGuard on your computer, you will need to set it up. 

 

Configuring SensiGuard 
 

When you launch SensiGuard for the first time, you will be prompted to set it up. This one time setup is 

necessary, as you set up a password and security questions that you will use later on to access protected 

files and folders.  

 

To configure SensiGuard: 

 

1. Launch SensiGuard by double-clicking on the SensiGuard shortcut on your desktop. 

 

2. If you get a UAC prompt, click Allow. 

http://www.sensiguard.com/download
http://www.sensiguard.com/support


3. The SensiGuard Setup Wizard will appear. Click Next to proceed with setup. 

 

4. Follow the onscreen instructions to select and answer three security questions. These security 

questions are created to help you recover your password in case you forget it. Remember that password 

recovery requires you to answer all three questions correctly. Please make a note of your answers. 

5. Select the question from the drop-down list and type your answer in the field below. Repeat the 

process to select and answer all three questions. 

 

6. When all three questions are selected and answered, click on Next to proceed to the next screen. 

7. Now you will need to set up a password. Enter the password of your choice and confirm it by entering 

it again in the Confirm Password field. You will need this password to lock, unlock or shred files using 

SensiGuard.  

8. Click Finish. 

 



You will then be offered to either purchase the software, enter your purchase confirmation code or 

continue using the trial version of SensiGuard. 

 
 

You will be prompted to enter your password every time you launch SensiGuard from your desktop.  

 

 

Viewing Files and Folders 
 

SensiGuard’s interface is a lot like Windows Explorer’s. The left-hand pane displays the files and folders 

available on your desktop and the right-hand pane displays the files/folders available on your hard drive. 

There are also useful tips and a link to SensiGuard video tutorial. By default, the folders are displayed in 

the Details view 

 

You can customize file and folder options by clicking on the View menu item. You can select which items 

are displayed and select the desired size of the icons. 

 



 
 

To change folder appearance: 

 

1. Open SensiGuard and click on the View menu item 

2. Select your preferred folder appearance. For example, click on Large Icons if you want your files and 

folders to be displayed as large icons. 

 

Locking and Unlocking Files 
 

SensiGuard makes protecting your information really easy. You can lock files and folders that contain 

sensitive information and unlock them when you need to view them. Locked files and folders cannot be 

opened by anyone unless they are unlocked. In order to unlock locked files, you need to enter your 

password. This means that unauthorized users will not be able to open your files even if they gain access 

to your computer. This way your confidential information will stay protected even if your laptop is 

stolen or if your PC is used by other people in your home or office.  

 

You can lock and unlock your files and folders in two different ways: 

 

1. Using the SensiGuard interface 

2. Using SensiGuard context menu in Windows Explorer 

 

Lock and Unlock Files from the SensiGuard Interface 
 

You can lock and unlock files and folders using the program interface.  

 

 

 

 



To lock files: 

 

1. Launch SensiGuard by double clicking on the SensiGuard shortcut on your desktop. You will be 

prompted to enter your password. Type in your password and click OK. The SensiGuard application 

window will be displayed. 

2. Browse to the files or folders you wish to lock either using the tree structure in the left-hand pane or 

using the icons in the right-hand pane.  

3. Select the file or folder you wish to lock. 

4. To lock the file or folder, click on the Lock button that is located at the top of the program window. 

 

 Note: When you lock a folder, all files in the folder are locked. 

5. Alternatively, select the file to be locked, click on Edit in the menu and select Lock from the drop-

down list that appears. 

 

The selected file or folder will be locked. You can unlock it whenever you want either using the 

application interface or using the Windows Explorer context menu. 

 

To unlock files: 

 

1. Browse to the file or folder that you wish to unlock. 

2. Select the file or folder and then click on the Unlock button.  



 

Note: When you unlock a folder, all files in the folder are unlocked. 

3. Alternatively, select the file to be locked, click on Edit in the menu and select Unlock from the drop-

down list that appears. 

4. The selected file folder will be unlocked and you can view the file(s). 

 

Lock and Unlock Files Using Windows Explorer Context Menu 
 

To make protecting your sensitive information easier, SensiGuard supports context menu options. You 

can lock and unlock files and folders directly from Windows Explorer without launching the application. 

 

To lock files: 

 

1. Browse to the file or folder you want to lock and right-click on it. 

2. Select SensiGuard from the context menu and select Lock from the pop-out submenu that appears. 

3. The selected file/folder will be locked.  

 

To unlock files: 

 

1. Browse to the file or folder you want to unlock and right-click on it. 

2. Select SensiGuard from the context menu and then select Unlock from the pop-out submenu that 

appears. 

3. The selected file/folder will be unlocked and you will be able to view the file(s). 

 

Personal Encryption 
 

SensiGuard has a feature called Personal Encryption that allows you to share encrypted files with any 

other SensiGuard user. This feature generates a public decryption key that you can share with your 

friends, family and colleagues, so that they can open the file using their copy of SensiGuard.  

 



When you run SensiGuard for the first time, you will be prompted to create a pair of encryption keys - a 

Private key and a Public key.  

 

 
 

The Private key is automatically saved on your hard drive and is locked with your password. The Public 

key is also saved on your hard drive and it can be exported. When you send encrypted files to other 

users, you will need to send them your Public key, so that they can open the files. 

 

 
 

Here is how to use Personal Encryption: 

 

1. Click on the Personal Encrypt Selection button in the program window. Alternatively select the 

Personal Encrypt option from the Tools menu or from the SensiGuard context menu 

 

 



2. You will be prompted to select the file you want to encrypt and select the key that belongs to the user 

you want to share the file with 

 

 
 

 
 

3. The file will be encrypted and only the target user will be able to open the file. 

 

Shredding Files 
 

SensiGuard has a built-in file shredder. The file shredder enables you to shred files that contain sensitive 

information so that they don’t fall into the wrong hands. Shredded files are permanently deleted and 

cannot be recovered even with the help of professional file recovery software. 

 



While this feature is extremely useful for deleting files containing your confidential information, be 

careful while using it since it’s impossible to recover shredded files. 

 

Files and folders can be shredded in two ways: 

 

1. Using the SensiGuard interface 

2. Using SensiGuard context menu in Windows Explorer 

 

Shredding Files from the SensiGuard Interface  
 

Files and folders can be shredded from the SensiGuard application window. Here is how: 

 

1. Launch SensiGuard by double-clicking on the SensiGuard shortcut on your desktop. 

2. You will be prompted to enter your password. Type in your password and click OK. The SensiGuard 

application window will open. 

3. Browse to the file or folder you wish to shred and click on it to select it. 

 

4. Click on the Shred button at the top of the program window. 

 Note: When you shred a folder, all files in the folder are shredded. 

5. Alternatively you can select the file you want to shred, click on Edit menu item and select Shred from 

the drop-down menu that appears. 

6. The system prompts for confirmation to shred the selected file/folder. Click OK. 

 

Shredding Files Using the Windows Explorer Context Menu 
 

You can speed up file shredding by shredding them directly from Windows Explorer using the 

SensiGuard context menu. To shred files from Windows Explorer, do the following: 

 

1. Browse to the file/folder you wish to shred and right-click on it. 

2. Select SensiGuard from the context menu and then select Shred from the pop-out submenu that 

appears. 

3. The system will prompt you to confirm shredding. Click OK. 



4. The selected file/folder will be shredded. 

Note: When you shred a folder, all files in the folder are shredded. 

 

Installing a SensiGuard Vault on a USB Drive 
 

SensiGuard USB Vault is the ultimate flash drive security solution. It lets you keep the files and folders 

on USB flash drives and memory cards 100% secure. SensiGuard USB Vault needs to be installed 

separately on each USB drive you want to encrypt.  

 

Installing SensiGuard USB Vault 
 

Once SensiGuard is installed on your system, you will see two new icons on your desktop. The bottom 

icon is your USB Vault installation file. Double click on the USB Vault icon to begin the installation. 

 
 

In the USB installation window that appears select the USB drive where you want to install SensiGuard 

USB Vault. If you have only one USB drive connected to your computer, it should be pre-selected. Enter 

the password of your choice and confirm it.  

 

 
 

SensiBox.exe and sensidocuments will be added to your USB drive. 

 



 
 

Encrypting Files with SensiGuard USB Vault 
 

To encrypt files with SensiGuard USB Vault, double click on SensiBox.exe. You will be prompted to enter 

your password.  

 

 
 

Enter your password and click OK. The USB Vault screen will appear. 

 

 
 

To instantly encrypt files, simply drag and drop them into the vault. 

 

Using the USB Vault 
 

The files that you add to the USB Vault can be opened and used on any computer, even if the computer 

doesn’t have SensiGuard installed. Files can be opened either using the vault application or using the 

Windows Explorer context menu. 

 



Opening Files from the USB Vault Application: 
 

1. Connect the USB flash drive to a computer and double click on the drive name to open it. Open the 

Vault by double clicking on the SensiGuardVault.exe icon. 

2. The USB Vault will prompt you to enter your password.  

3. The Vault application window will open. 

 

4. To unlock files, select the files that you want to use. Then drag and drop the locked files to the 

desktop or any other folder.  

5. Your files will be decrypted and you will be able to use them straight away. 

 

Opening Files Using the Windows Explorer Context Menu 
 

You can also open files in the USB Vault and unlock them without launching the program. Here is how: 

 

1. Right-click on the sensidocuments folder and select SensiGuard from the context menu. Then select  

Unlock from the pop-out menu that appears. 

 



2. All files in the sensidocuments folder will be decrypted. Select the files that you want to use, then 

drag and drop them to the desktop or any other folder.  

 

Managing Your Password 
 

Using SensiGuard requires a password. You need to enter your password to launch SensiGuard, lock, 

unlock and shred files. 

 

Changing Your Password 
 

For security reasons it’s recommended to keep changing your password every now and again, at least 

once a month. You can change your SensiGuard password using the Change Password option. This 

option will let you change the password for already locked data, as well for all newly locked files. 

 

Note: You can change your password only if you know your current password. Otherwise you will have to 

reset your password using the password reset option. 

 

To change your SensiGuard password, do the following: 

 

1. Launch SensiGuard by double-clicking on the SensiGuard shortcut on your desktop. 

2. You will be prompted to enter your password. Type in your password and click OK. 

3. Select Tools from the main menu and then select Change Password from the drop-down list that 

appears. 

  

4. The Change Password window will appear. 

5. Enter your current password in the Old Password field, your new password in the New Password and 

Confirm Password fields and click OK. 

 



6. Your password will be changed. 

 

Now you will be able to unlock files locked with your old password using the new one. 

 

Resetting a Forgotten Password 
 

If you have forgotten your password, you can reset it using the Forgot Password option. To reset your 

password, do the following: 

 

1. Double click on the SensiGuard icon on your desktop. Alternatively, click on the Tools menu item and 

select Forgot Password 

 

2. You will be prompted to enter your password. Click on the I forgot my password link below the 

password field. 

 

3. In the new window enter the correct answers to the three security questions that you selected when 

you set up SensiGuard. 

4. Click Next. If all questions were answered correctly, a password reset window will appear. 

 



6. Enter a new password in the New Password and Confirm Password fields and click OK. 

7. Your password will be reset and you will be able to use SensiGuard again. 

 

Note: use this option with caution because all files locked with the previous password will be erased! 

 

Uninstalling SensiGuard 
 

You can uninstall SensiGuard from the Control Panel, just like any other program. Alternatively you can 

run the uninstall wizard that is installed on your system during the SensiGuard installation. 

 

To uninstall SensiGuard from the Control Panel: 

 

1. Click on Start and go to the Control Panel. 

2. Open Add or Remove a Program (Windows XP) or go to Programs and select Uninstall a Program 

(Windows 7). 

3. Locate SensiGuard, highlight it and click on Uninstall 

4. SensiGuard will be uninstalled from your computer. Reboot your PC for the changes to take effect. 

 

To uninstall SensiGuard using the uninstaller: 

 

1. Click on Start, then navigate to Programs - SensiGuard. 

2. In the submenu, locate Uninstall and click on it. 

3. The system will ask you to confirm the removal of all SensiGuard components from your system. Click 

Yes. 

4. SensiGuard will be uninstalled from your computer. You will need to restart your computer for the 

changes to take effect. 

 

 


